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1 Introduction

Read this manual if you who are deploying Bria without the help of a system administrator. If you are working 
in an enterprise that has a system administrator who is deploying Bria across the enterprise, read the user guide 
“Using Bria 3 for Windows – for Enterprise Deployments”.

Bria is a softphone from CounterPath that enables you to make VoIP voice and video calls, send and receive 
instant messages, share online status (presence) information, and exchange files. 

Standard Telephone Features
The CounterPath Bria softphone has all standard telephone features, including:

• Call display and Message Waiting Indicator (MWI).
• Speakerphone and Mute.
• Redial, Hold, Do Not Disturb.
• Call history – list of received, missed, and dialed calls.
• Call forward.
• Call transfer.
• Call record.
• Auto answer.
• Six-party audio conferencing.
• Three-party video conferencing.

Enhanced Features and Functions
Bria also supports the following features and functions:

• Video
• Support for several languages in addition to English: French, German, Italian, Portuguese, and Spanish. 
• IM and presence using the SIP SIMPLE protocol or the XMPP protocol.
• IM conferencing (group chat) via an XMPP account.
• Contact list containing the individual user’s contacts.
• Directory containing names from a shared LDAP directory or Microsoft® Active Directory®.
• File transfer via an XMPP account.
• Support for DTMF (RFC 2833 or inband DTMF). 
• Automatic detection and configuration of audio and video devices.
• Acoustic echo cancellation, automatic gain control, voice activity detection.
• Support for the following audio codecs (not all these codecs are included in the retail brands):

AMR Wideband (G.722.2), Broadvoice-32, Broadvoice-32 FEC, DVI4, DVI4 Wideband, EVRC, 
G.711aLaw, G.711uLaw, G.722, G.723, G.726, G.729, GSM, iLBC, L16 PCM Wideband, Speex, 
Speex FEC, Speex Wideband, Speex Wideband FEC.
1
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• Support for the following video codecs:
H.263, H.263+ 1998, H.264.

• Automatic selection of the best codec based on the other party’s capability, the available bandwidth, and 
network conditions. Bria switches the codec within a call in response to changing network conditions.

• Compliance to 3261 SIP standard.
• XMPP compliance as follows:

• RFC 3920
• RFC 3921
Supported extensions:

• XEP-0004
• XEP-0016
• XEP-0022
• XEP-0077
• XEP-0085
• XEP-0092
• XEP-0115

• Support for these firewall traversal solutions: STUN, TURN, or ICE.
2



2 Installation and Setup

2.1 Getting Ready

SIP Account Information
After choosing a VoIP service provider, you will need the following information:

• User name and password
• Authorization Name (if applicable)
• Domain
• Firewall traversal and other network information; see “Configuring Bria” on page 49.

XMPP Accounts
If you use an XMPP service for instant messaging or presence, you will need the following information:

• Jabber ID: user name and domain. For example, jsantos@domainXMPP.com.
• Password
• Connection information: see “XMPP Account” on page 52.

System Requirements
Processor Minimum: Pentium 4® 2.4 GHz or equivalent

Optimal: Intel Core 2 Duo or equivalent; Video Card with DirectX 9.0c support
Recommended to support HD video: Intel Core 2 Duo or equivalent with minimum 3.0 
GHz, or a triple- or quad-core processor; Video Card with DirectX 9.0c support.

Memory Minimum: 1 GB RAM
Optimal: 2 GB RAM.

Hard Disk Space 50 MB

Operating System Microsoft Windows XP Service Pack 2
Microsoft Windows® Vista®, 32-bits and 64-bits arch
Microsoft Windows 7.

Additional Microsoft Windows Installer 3.1
Microsoft .NET 3.5 SP1
Microsoft VC 9.0 Runtime Service Pack 1
(Note that the installer will take care of installing those if you do not have them).

Connection Minimum: IP network connection (broadband, LAN, wireless)
Recommended to support HD video: A 2.0 Mbps connection
Note that Bria requires a continual internet connection.

Sound Card Full-duplex, 16-bit or use USB headset

Web browser Microsoft Internet Explorer® 6.0 or later.
3
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Multimedia Device Requirements
Bria requires both speakers and a microphone to make calls. Any of the following configurations are 
acceptable:

• External speakers and microphone
• Built-in speakers and microphone
• Dual-jack multimedia headset
• Bluetooth® multimedia headset
• USB multimedia headset
• USB phone. 

HID-compliant devices can be configured to work with Bria.

Video Cameras
Calls made with Bria will work without a video camera, but a video camera is necessary to allow other parties to 
see your image. Bria will work with most USB video cameras.

2.2 Installing Bria
Runthe Bria installer and follow the prompts in the install wizard.

If you want to configure Bria immediately, then at the final step of the wizard, select Launch Bria.
4
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2.3 Starting Bria
First-time Startup
If Bria is not already running, start it as you would any other program: Use the Windows Start menu or 
double-click the desktop icon. The Bria Login dialog appears with the Profile set to “No login required”. 

Leave the profile as “No login required” and click continue. The softphone GUI appears. (Login is used only in 
enterprise deployments in which a system administrator has set up a provisioning server to automatically 
configure Bria for you.)

Subsequent Startups
After the first-time startup, the Bria Login dialog will not appear if you selected the No login required profile. 

(If you started up the first time with “No login required” but in fact you do need to log in, go to the menu and 
choose Softphone > Preferences and enable login. See page 64.)
5
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2.4 Configuring Bria

Setting up Accounts
After obtaining SIP, SIMPLE, and (if applicable) XMPP account information from your VoIP service provider, 
you can set up Bria accounts.

1. From the Bria menu, choose Softphone > Account Settings. The SIP Account window appears.

Set up the SIP Account

2. In the Account tab, complete the User Details area with the information obtained from your VoIP service 
provider. 

3. Complete the remaining tabs as specified by your service provider or to suit your setup. Settings that you 
may need to change immediately include:

• Account tab, Domain Proxy area.
• Topology tab, if your computer is on a network and/or behind a firewall.
For more information, see “Configuring Bria” on page 49.

4. When done with the SIP account, click OK; the account is created and registered. 

Set up the XMPP Account

5. If you are setting up an XMPP account, choose Softphone > Account Settings again. This time the Account 
Settings window appears, showing the SIP account you have already set up.

6. Click Add > New XMPP Account. The XMPP Account window appears. 

7. Complete the window with the information obtained from the XMPP service provider. For more 
information, see “Configuring Bria” on page 49

8. When done with XMPP account, click OK.

Enable the Accounts

9. On the Account Settings window, click Apply to register the newly added account. Click OK when the 
Status column is “Ready”. 
6
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Setting up for Voicemail
Your VoIP service provider may offer voicemail. If it does, then you can set up some voicemail features in Bria. 
See page 55.
7
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Setting up a Contact List
Typically, you will want to create contacts in order to easily make phone calls, send IMs and transfer files. 

Selecting the Contact Storage Method

1. From the Bria menu, choose Softphone > Preferences. Display the Contact Storage panel./

2. Select the contact storage method: typically “local” or “Outlook Personal Contacts” (to use your 
Microsoft® Outlook® address book directly from Bria). See page 34. 

Populating the Contact List

You can set up contacts in several ways:

• If you are using Outlook Personal Storage, your Bria contact list will automatically be populated with these 
contacts. 

• If you are using local storage, you can import a contact list from a file or from another application. See 
page 34.

In addition:

• During a call that you place or receive, you can add the other party to your contact list. See “Handling an 
Established Call” on page 19.

• You can add addresses to the Contact list one by one. See page 36 (if using local storage) or page 38 (if 
using Outlook contacts).

For general information on contacts, see page 33.

Setting up for Presence
Presence allows your contacts to see your online status and also allows you to see their online status. 

You can set up for presence if your VoIP service provider supports it; check if it is supported and if so, whether 
it is supported over SIP (using SIP SIMPLE) or XMPP. 

Presence is handled over one of your accounts. If you only have a SIP account, you can share presence 
information over that account. If you have a SIP account and an XMPP account, you can share presence 
information over the XMPP account, not the SIP account.

Using the SIP Account

1. From the Bria menu, choose Softphone > Account Settings. Select the SIP account and click Edit.

2. On the Account panel, make sure to check Allow this account for IM/Presence.

3. On the Presence panel, set up the presence mode. Typically, the mode will be peer-to-peer (the default).

Using the XMPP Account

1. Make sure the XMPP account is enabled (Softphone > Account Settings).
8
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Verifying your Setup

View the contact list: some or all your contacts should have a presence icon besides their name. In order for a 
contact to include a presence icon, it must be “presence-ready” and you must be subscribing to the contact. 
(“Presence-ready” means that the contact has an address that allows for presence data to be shared.)

If none of your contacts show an icon and you expect at least one of them to show it, follow the steps in this 
table:

2.5 Troubleshooting
Bria includes these tools for helping you troubleshoot problems:

• You can verify that your microphone, speakers and camera are working and can set the volume to a 
comfortable level without having to actually place a phone call.

• You can verify that you are successfully connected to the network. 
• While you are on a phone call, you can test the quality of the audio. Note that to perform a valid test, you 

should be on an established call (not a call attempt). 
• As a final option, you can create logs of your activity and send them to customer support.

See page 83.

2.6 Checking for Bria Updates
To check for updates to Bria, choose Help > Check for Updates. The Auto Update window appears.

• If a new version of the software is available, you can download it from this window.
• If no newer version is available, this window informs you that your version is up to date.

Contact Storage 
Method

Presence 
Account A contact is “presence ready” if If the contact is “presence ready” and 

the presence icon still does not show

Local SIP The contact has an address in the Softphone 
field. Verify this on the Contact Profile; see 
page 36. 

Display the Contact Profile for the contact and 
make sure the “See this person’s online 
presence” field is checked.
If you initially populated the contact list by 
importing a file, the easiest solution is to redo 
the import and check the correct presence 
option. See page 34.

Local XMPP The contact has an address in the Jabber field. 
Verify this on the Contact Profile; see page 36. 

Outlook SIP The Outlook contact has an address in the 
“softphone mapping” field. The “softphone 
mapping” field is identified in Preferences > 
Contact Storage in “Field to use for Softphone 
address”. See page 38.
Bria recognizes the “softphone mapping” field 
as containing data that can be used for a phone 
call and for IM and presence.

• On the Bria contact list, select the affected 
contacts, right-click, and choose Subscribe 
to presence. (If this menu item does not 
appear then none of the selected contacts 
have a value in the “softphone mapping” 
field (in Outlook) and therefore cannot be 
subscribed to.)

• If you specified the wrong “softphone 
mapping” field on the Preferences > 
Contact Storage panel, you can change it.

Outlook XMPP The Outlook contact has an address in the IM 
field. See page 38.

On the Bria contact list, select the affected 
contacts, right-click, and choose Subscribe to 
presence. 
9
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3 Making Phone Calls

3.1 Starting and Quitting Bria
If Bria is not already running, start it as you would any other program: Use the Windows Start menu or 
double-click the desktop icon. Bria appears. To quit Bria, click Softphone > Exit or press Ctrl-Q.

3.2 The Onscreen Softphone 

Show/hide dial pad

Show/hide directory, IM archive, and workgroup

Open/close video window

Close to system tray. This icon does 
not shut down Bria

Bria menu. 
See below.

Resources. 
See page 47

Call entry field 
See page 13.

Minimize to system tray
11
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The Bria Menu
Bria. •Accounts. These settings control how Bria interacts with your VoIP service provider, and are set 

individually for each account. See “Configuring Accounts” on page 49.
• Preferences. These settings control the way that you work with Bria and apply to all accounts. See 

“Configuring Preferences” on page 64.
• Exit. To shut down Bria. You can also exit by pressing Ctrl+Q.
View. Changes how Bria looks. 

Contacts. Lets you work with contacts. 

Actions. Lists the actions that you can perform, depending on the current “state” of Bria. For example, if a 
contact is selected, it lists all the actions that can be performed on that contact. 

Help. Provides access to various service-related features. 

USB Device Alert
If your headset is a “HID-compliant device”, the USB Device alert may appear the first time you start Bria. You 
can assign functions to the headset. For example, you can set the green button so that it answers an incoming 
call.

If you click Yes, the USB Device Button Setup window appears; see page 69.

If you click No, you can still access this window from the Softphone > Preferences > Devices panel (page 67).
12
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3.3 Placing a Call
You can contact someone using a traditional phone number (if supported by your VoIP service provider) or a 
softphone address (for example, kperera@domainA.com).

Place the call as described in the table below. The outgoing call opens in its own call panel, below any other 
existing call panels. You will hear a ringing tone while Bria attempts to make a connection.

A call panel opens showing the call attempt, then the call established. For information on working with the call, 
see “Handling an Established Call” on page 19.

Dealing with an Auto Attendant

If you know that your call will be answered by an auto attendant and you know what menu items you will 
choose, you can include those menu items (DTMF) in the phone number when you dial it:

• Before the first DTMF number, include at least one capital P.
• You can include other Ps. Each P causes Bria to wait one second before sending the next character. 
• At the end of the input, you must include a ; character.

Example: To dial a number, add a 3-second delay and then press 44, enter this in the call entry field:

604551212PPP44;

Example: To dial a number, add a 6-second delay, then press 1 then 3 then 2, each with a two second delay:

604551212PPPPPP1PP3PP2;

Option From the... Description

Keying Dialpad or computer 
keyboard

1. Enter the number or address in the call entry field using the dialpad 
or the computer keyboard. To turn letters to numbers, see page 15

If entering a softphone address, you can enter the entire address 
(kperera@domainA.com) or just the name (kperera).
As you type, a suggestion for completing the entry may appear. 
Choose the suggestion or keep typing.

2. Click the Call button or press Enter. 

Drag-and-drop contact or 
previous call

Contacts or History tab Drag an entry from the Contacts or History tab. (If the tab contains lots 
of contacts, first search or filter the list.) 

Right-click a contact or 
previous call

Contacts or History tab Right-click an entry from the Contacts or History tab and choose Call.
(If the tab contains lots of entries, first search or filter the list.)

Double-click a contact Contacts tab Contacts have a “double-click” action that either makes an audio phone 
call or starts an IM. Each contact can be configured separately for this 
action. See the table on page 43.

Double-click a previous 
call

History tab Double-click an entry. An audio call is placed.

Redial Redial button • When the call entry field is empty, click the Call button.
• Or click the arrow in the call entry field and select a recent call. 

An audio call is placed.

Dialing Dialpad 1. If the dialpad is not visible, click the Show/Hide dialpad button.
2. Click the numbers on the dialpad to enter the phone number.
3. Click the Call button or press Enter.

From an instant message IM window Click the menu at the top of the IM window and choose Call.
13
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Call entry field

Click to place the call

Auto complete suggestions
14
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Selecting the Account to Use

This information applies only if you have more than one SIP account set up and enabled.

When you place a call, you can explicitly specify the account to use for that call. 

The account selection options appear only if you have two or more SIP accounts that are enabled and being used 
for phone calls. To make an account “useable” for phone calls, choose Softphone > Account Settings, select the 
account and change the Use For fields on the Accounts tab (page 53).

Letters to Numbers
You can type letters and Bria will convert the letters to numbers when placing the call:

Choose the account to use.

This account will be used for all 
calls until you select a different 
account or go back to Auto 
Select

If you choose Auto Select, then the 
account to use depends on your dial plan 
rules (page 88). If there are no dial plan 
rules, then the “preferred” account 
(page 49) is used.

Letters-to-numbers 
mode indicator

Click

Type the phone number 
using numbers and letters, 
as desired

When you click Call, the call panel will open and 
the call will be placed. The call panel will show the 
phone number all in numbers.
15
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Hiding your Identity
You can hide your identity on a call, so that the other person will not see your name or number on their phone. 
Your ID will be hidden for all outgoing calls until you turn off Hide my Number.

Hide my Number is automatically turned off when you shut down.

Placing another Call
To place a new call (without hanging up on the current call), simply place the call in the normal way. A second 
call panel opens below the current call. The first call is automatically put on hold.

Switch between the different calls by clicking Resume on the desired call panel. That call becomes the active 
call and all other calls are on hold. 

There is no limit to the number of calls you can make, although eventually the quality of audio and video will 
degrade because of limitations on the computer. We recommend no more than six concurrent calls. 

Turn Hide my Number on or off

The Anonymous indicator appears on the 
dashboard. Place the call in the usual way.

Existing call

New outgoing call
16
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3.4 Handling Incoming Calls
Bria must be running to answer incoming calls. (If Bria is not running, incoming calls may be directed to 
voicemail; check with your VoIP service provider.)

As soon as an incoming call is received, a call panel appears, showing information about the call. 

In addition, the Call Alert box appears, even if Bria is minimized. For information on setting call alert 
preferences, see page 65.

   

Action From the... Description

Answer Call panel or Call Alert box Click Answer. 
If you are on another call, that first call is automatically put on hold. You are 
now talking to the new caller.

Call panel Click Forward; a call entry field appears.
Enter the name or number to forward to and click Forward Now.

Decline Call panel or Call Alert box Click Decline. There will be a busy signal. The call may be directed to 
voicemail (if you have this service).

Video Call panel or Call Alert box The caller wants to include video.
Click to answer a video call and start sending your video immediately

Audio Call panel or Call Alert box The caller wants to include video.
Click to answer without video; if you want (and if you have a camera), you will 
be able to add video later. 

Click to answer a video call 
and start sending your video 
immediately

Click to answer without video; if you 
want (and if you have a camera), you 
will be able to add video later. 

This is the alert for a video callThis is the alert for an audio-only call
17
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Auto Answer
You can set Bria to automatically answer all incoming calls. 

To turn auto answer off and on, in the Call panel click Options > Auto Answer. The AA icon appears in the 
menu bar.

Auto answer is initially configured to auto-answer after one ring, and to send only your audio when the call is 
established. To change this configuration choose Softphone > Preferences > Call Automation.

Auto answer is automatically turned off when you shut down.

Turn Auto Answer on or off

The Auto Answer indicator appears on the 
menu bar. 
18



Bria 3 for Windows User Guide – Retail Deployments
3.5 Handling an Established Call
While the call is in progress you can:

• Control the audio: use the speakerphone, mute the call, control volume.
• Record the call.
• Put the call on hold.
• Add the caller as a contact.
• Transfer the call. See the next page.
• Add video. Pause and resume video when video is already present. See “Handling Video Calls” on page 22

Ending a Call
Click the red End call button on the Call panel (the call can be active or on hold). The call panel closes after a 
few seconds.

Open or close the video window. 
See page 22

Speakerphone

Mute
Add the current caller as a 
contact. See “Adding a 
Contact using an Existing 
Address” on page 37.

Volume control

Voicemail; page 27

See page 24Video. See page 22Transfer. See page 20

Start recording

See page 29

Place another call (current call is 
automatically put on hold). See page 16
19
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3.6 Transfering a Call

Basic (Unattended) Transfer – Transfer this Call
You can transfer a call to any number without first speaking to the other person. The call will be handled in one 
of these ways:

• If you hang up immediately and the other person does not answer, the person you are transferring will have 
to hang up.

• If you do not hang up immediately and the other person does not answer, the call will come back to you

Type a name or number, or drag a contact 
into the field. 

Click the Transfer button

The call is put on hold and a call entry field appears.

The call may end immediately.

Or it may show “calling”, In this case, do not 
hang up immediately: if the other person does 
not answer, the call will come back to you.

Then click Transfer Now. 
20
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Attended Transfer – Call then Transfer
You can first speak to the target (the person you are transfering the call to), then click Transfer to complete the 
transfer.

When the other person answers, the Transfer 
Now button is enabled

Click the Transfer button

Type a name or number, or drag a contact 
into the field

Then click the down arrow and choose Call first

The call is put on hold and a call entry field appears

When you are ready, click 
Transfer Now. The call panel 
closes

Bria phones the new person

You can hang up the 
second call and return to 
the first call

You can cancel the transfer 
request and return to the 
first call

Or if the other person does not want to 
take the call, click Cancel and return to 
the first call
21
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3.7 Handling Video Calls

Placing a Video Call
You can start a call with video. See the table.
 

How From the... Description

Keying Dialpad or computer 
keyboard

1. Enter the number or address in the call entry field using the dialpad 
or the computer keyboard. To turn letters to numbers, see page 15.

If entering a softphone address, you can enter the entire address 
(kperera@domainA.com) or just the name (kperera).
As you type, a suggestion for completing the entry may appear. 
Choose the suggestion or keep typing.

2. Click the arrow beside the Call button and choose Video call. 

Right-click a contact or 
previous call

Contacts or History tab Right-click an entry from the Contacts or History tab and choose Video 
Call. 
(If the tab contains lots of entries, first search or filter the list.)

Click the down arrow and 
choose Video call

Call entry field

Show/hide dialpad
22



Bria 3 for Windows User Guide – Retail Deployments
Adding Video

If you have a camera, you can click Start Video ( ) in the call panel. When you add video, the other party 
may (or may not) start sending their video to you.

Other Party Adds Video
If the other party starts their video, your video window automatically opens and the video is played. You can 

start sending your own video, if desired (and assuming you have a camera) by clicking Start Video( ) in the 
call panel.

Pausing and Resuming Video
Click Stop Video in the call panel or close the video window to pause sending your video.

Click Start Video to resume sending your video; the video window will open.

Status of your videoStart Video and Stop Video

Show/hide video window

Click to configure the camera
23
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3.8 Conference Calls

Starting a Conference Call

From the Dashboard

From an Existing Call 

• Enter the number or address by typing

• Or select from the redial list

Then choose Start conference call

• Or drag a contact or history item

From One Established Call

From Two Established Call
24
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Managing the Conference
 

Adding More Participants
You can add more participants to an existing conference in any of these ways:

• Right-click on a contact or history item and choose Add to Conference Call.
• In the conference call panel, enter a name in the call entry field and click Add.
• Add in a separate call that is not part of the conference call: In the call panel for the individual call, click the 

down arrow and choose Merge Calls. This call is added to the conference call.

Send an Instant Message
Click the down arrow beside a participant name and choose Send Instant Message.

Removing a Participant
To remove one call from the conference, click the down arrow beside a participant name and choose Separate. 
The call becomes a separate call.

Ending the Conference
To hang up on everyone, choose End conference from the conference menu.

Suspending the Conference
To suspend the conference, choose Hold from the conference menu. All participants are put on hold. 

If you need to speak to one participant separately, put the conference on hold, separate the one participant from 
the conference, take that person off hold. When done, merge the participant back into the call.

Conference call entry field

Participant menu 

Mute. When you mute during a video call, you may also 
want to click Stop Video to stop the video feed.

Conference menu
25
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Video Conference Calls 

Including Video in a Conference
When you start a conference from established calls, video is included if at least one of the calls already includes 
video. Video is sent to all the participants.

When you start a conference from scratch, video is not included. You can open your video window and choose 
to add video at any time. Video is sent to all the participants.

How Video Is Shared
The conference host (the person who starts the conference) serves as the host for other video. Whatever the 
conference host is receiving will automatically be sent to the other parties. 

If the conference host pauses or stops video, other participants will no longer receive video.

This person already has video. 

This person does not have video. To remedy this 
situation, stop video and start it again. Video will be 
sent to all the current participants.

Start and stop video

Closing the video window stops sending 
video.
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3.9 Voicemail
If your service includes voicemail and you have set up voicemail options (page 55), then when you have 
voicemail messages, the voicemail icon appears at the top of the phone (the icon may include a number). You 
can click the icon to automatically connect to voicemail and listen to your messages.

3.10 Forwarding Calls
Forwarding Calls
You can enable or disable forwarding so that calls will be forwarded to another number. You can set up 
forwarding so that calls are always forwarded or so that calls are forwarded only when you are on another call.

To enable forwarding through Bria, click Softphone > Account Settings. Choose an account and click Edit, then 
click the Voicemail tab. For complete details, see page 55.

3.11 Workgroups
Typically, workgroups are used only in enterprises and are set up by the system administrator.

3.12 Working in Deskphone Mode
Typically, deskphone mode is used only in enterprises. 

Voicemail icon
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4 Other Bria Features

4.1 Instant Messaging

Sending an IM
1. You can send an IM to a contact who has a softphone address.

2. Type the message. Include emoticons and formatting, as desired. 

To insert a return in the message, press Enter. (You can control the behavior of Enter and of Ctrl+Enter on 
the Softphone > Preferences > Application panel.)

3. Click Send.

Receiving an IM
When an IM is received, either the IM window or a Call Alert pops up. (To control which window appears, 
choose Softphone > Preferences > Application.)

From the Contacts tab Right-click on the contact and choose Send Instant Message. The contact must 
have a softphone address.

An active phone call If the person is a contact, choose Send Instant Message from the call panel 
menu.

An active conference call If the participant is a contact, choose Send Instant Message from the participant 
menu.

Click to select more actions

Message input area
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Conference IM – Group Chat
Group chat allows you to exchange instant messages with a group of people in the same session. All people 
must have XMPP accounts configured in order to participate in group chat.

There is no limit to the number of participants in a group chat. You can also invite more participants during a 
group chat session.

1. In the Address Book on the Contacts tab, select the desired contacts. Contacts must be online.

2. Right-click the last selected contact and choose Start Group Chat. The invitation dialog appears.
 

Inviting More Participants
To invite more participants to a group chat, select online contacts from your Contact List and drag them to the 
Group Chat window. Any participant in the group chat can invite more participants.

Leaving a Group Chat
To leave group chat, close the group chat window.

If you have started the group chat and you leave the session, the session continues with the remaining 
participants.
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Viewing the IM Archive
You can view your recent IM activity for any contact or group chat session.

On the menu, choose View > Instant Message Archive. In the Archive window, select a contact from the list. 

Right-click to delete 
the selected 
conversation

Delete all the conversations for 
the selected contact
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4.2 Sending and Receiving Files

Sending Files
If you have an XMPP account, you can send files to another contact who has a Jabber address (meaning that 
they have an XMPP account). 

1. Choose one of these actions:

• Right-click a contact and choose Send Files; a standard Open dialog box opens. 
Select the files to send and click Open. The Send Files dialog appears with a “waiting” message. If you 
want, you can cancel the send before the other person retrieves the file.

• Drag a file from a folder to the IM window.

To cancel the file transfer before the other person retrieves the files, click Cancel.

Receiving Files
If you have an XMPP account, another person with an XMPP address may send you files. The following dialog 
appears, to allow you to save the file.

The file is saved to the location specified in Preferences > Advanced (page 82). 
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5 The Contacts Tab

The Contacts tab displays your contacts and lets you specify multiple contact methods for them, including:

• Softphone address 
• Home phone number, business phone number, mobile phone number

Contacts are typically organized into groups. Bria includes built-in groups: “Family”, “Friends” and “Work”. 
You can add more groups, as desired.

Add a Contact

The online status of others. See page 40.

Filter contact list

Search entire contact list
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5.1 Populating the Contact List
At any time, but particularly when you first deploy Bria, you may want to populate the contact list with contacts 
from an external source.

Synchronizing with Microsoft Outlook
You can populate the Bria contact list by synchronizing with your Microsoft® Outlook® contacts. In this case, 
you are actually using your Outlook contacts from within Bria. When you start Bria, contacts are fetched from 
Outlook. When you add or modify a contact in Bria, the contact is actually saved in the Outlook personal 
address book. 

To synchronize with Outlook, set your contact list storage method to Microsoft Outlook. See page 79.

If you started using Bria with contact storage set to Local and then want to switch to Outlook, you can export 
the contacts currently stored locally in Bria and then import them into Outlook. Then when you switch to 
Outlook, these contacts will reappear along with all the other contacts from Outlook. See below for information 
on import and export.

Importing Contacts
You can populate the Bria contact list by importing from an external file or files. The new contacts will be 
added to the existing contacts. 

If you are using Microsoft Outlook to store contacts, you cannot import or export; these menu items are 
disabled.

You can import a contact list from:

• A comma-separated file. Use this method to import from a Microsoft® Excel® file. You will first have to 
set up the file; see below. 

• A vCard file (*.vcf file). A vCard is an electronic business card that is often attached to an e-mail.
• A Microsoft Outlook or Microsoft® Exchange contact list (a *.pst file). 

1. From the main menu, click the Contacts menu and choose Import Contacts. The Import Contacts wizard 
starts. 

2. As soon as you click Finish on the wizard, the Contacts tab in Bria is updated to show the imported entries. 

Setting up an Excel File for Import

1. Remove any introductory text or headings from the top of the file. (You can keep text at the end of the file; 
it will be ignored during the import.)

2. Insert a blank row as the first row, then insert the headings that Bria will use to interpret the meaning of 
each column. The columns can be in any order. Key headings are:

• uri. Bria recognizes a value in this column as a softphone address and considers the address as one that 
can be phoned and as an address that can be used for IM/presence (if SIP is being used for IM/
presence). 

• jid: Bria recognizes a value in this field as a Jabber (XMPP) address and will map this field to the 
Jabber contact method for the contact. Bria considers a Jabber address as one that can be used for IM/
presence (if XMPP is being used for IM/presence).

• display-name, entry_id, given_name, surname
• business number
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• pres_subscription. Complete this column in one of  these ways:
• If you only want to share presence information with some of your contacts, fill in this column in 

the file. Enter “true” for contacts whose online presence you want to see, leave blank or enter 
“false” for others. During the import, you will be able to choose to share presence with only these 
contacts. Bria will subscribe to the presence of these “true” contacts, assuming that the user has a 
SIP (if using SIP for presence) or an XMPP address.

• If you want to share presence with all your contacts (or none), ignore this heading. During the 
import you will be able to choose to share with all (or none) of your contacts.

For a complete list of headings, see page 95.

3. Save the file as *.csv.

Exporting Contacts

You can export a contact list to a comma-separated file, a pst file or a vcf file.

1. From the main menu, click the Contacts menu and choose Export Contacts. The Export Contacts wizard 
starts. 

2. When you click Next, the export starts. The result is:

• For an Outlook export, the existing .pst file is updated to include the entries from the Bria contact list. 
If Outlook is open, the entries immediately appear in the contact list. 
All information in the Bria contact list is exported to Microsoft Outlook. Only information that can be 
displayed in Outlook actually appears in the Outlook Contacts window. Typically this means that all 
softphone addresses are exported (and stored in custom fields) but not displayed in Outlook.

• For other formats, a new file of the specified type is created.
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5.2 Managing Contacts and Groups
The following information does not apply if you are using your Microsoft® Outlook® address book from 
within Bria. Instead, read “Managing Contacts when Using Outlook” on page 38.

Adding a Contact

Click , or right-click a group and choose Add Contact to Group. The Contact Profile dialog appears. See the 
table.

Field Description

Display as
First name
Last name

Only the “Display as” name is required. This is the name that will appear in the call panel and the 
Call Alert when this person phones you.

Group Click to show the list of groups and check each group to add this contact to. 

Contact Methods You must enter at least one contact method. Enter as many contact methods as you want. Softphone 
entries, Jabber entries and e-mail entries must have the format <name>@<domain>.

See this person’s Softphone 
online presence

This box becomes enabled only if you have entered a softphone or Jabber address.
If you check this box, you will share your online status with this person; see page 40.

Introduction Message This button becomes enabled only if you have entered a softphone or Jabber address.
If you choose to see this person’s online status, you can enter a short message.

Double-click action Choose the desired method. This method will be used when you double-click this contact. 
For example, if you choose “IM:kperera@domainA.com”, then double-clicking this contact will 
open an IM window using this address (rather than any of the other addresses that exist for this 
contact).

On a new contact, this checkbox and the Introduction Message button 
become enabled once you enter a softphone address. On an existing 
contact, they become enabled if you enter another softphone address.
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Sharing Online Status

Online status information is handled by the account specified in the Accounts Settings window. To see which 
account is currently being used for online status information, choose Softphone > Account Settings; see 
page 49.

Contact Flyout 

Click a contact to show the Contact flyout. This flyout shows all the contact methods set up for the contact. You 
can click a contact method to perform its action.

Adding a Contact using an Existing Address
You can add a contact by capturing existing information: 

• If you are on a phone call with a non-contact, click the Add to Contacts button in the call panel.
• On the History tab, select an entry that is not a contact. Right-click and choose Add as Contact.

The Contact Profile dialog appears. Complete the dialog as desired and press OK.

If the contact method is Softphone or Jabber, an online status request is sent to this person. See “Sharing Online 
Status” on page 42.

Modifying the Contact List

Changing Contact Information

To change the information for a contact, right-click the contact and choose Edit Profile. The Contact Profile 
dialog appears (page 36). 

Moving or Deleting a Contact
• To drag one or more contacts to a different group, select them and drag to the title bar of the new group.
• To delete one or more contacts, select them, right-click, and choose Delete Contact or Delete Selected. The 

contacts are removed from this group. If a contact belongs to several groups, it is removed from all groups.

Adding, Deleting or Renaming Groups

Select any group, right-click, and choose the appropriate menu item. Contacts that have no group appear under 
“Ungrouped Contacts.” You can delete, but not rename, this group.

Click a contact method
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5.3 Managing Contacts when Using Outlook
The following information applies only if you have set up your Microsoft® Outlook® address book as your 
contact storage method and are therefore using this address book from within Bria.

Viewing a Contact
The flyout is a handy way to view the information you have for a 
contact without opening (editing) the Outlook contact dialog. Click 
once on the contact; the flyout appears.

Adding a Contact

Click , or right-click a group and choose Add Contact to Group. The Outlook Contact dialog appears. 
Complete the fields and save the information. The new contact will automatically appear in your Bria contact 
list.

One of the fields in this dialog is mapped to the Softphone field in Bria; Bria will assume that the phone number 
you put in this dialog can be used to place phone calls, send instant messages, and shared online status 
information. 

To check which field is mapped, choose Softphone > Preferences > Storage. See page 79.

Sharing Online Status

To share online information with a newly added contact, select the contact and right-click and choose Subscribe 
to presence. Online status information is handled by the account specified in the Accounts Settings window. To 
see which account is currently being used for online status information, choose Softphone > Account Settings; 
see page 49.

Adding a Contact using an Existing Address
You can add a contact by capturing existing information: 

• If you are on a phone call with a person who is not a contact, click Add to Contacts in the call panel
• On the History tab, select an entry that is not a contact. Right-click and choose Add as Contact.

The Outlook contact dialog appears. Complete the dialog as desired and press OK.

Modifying the Contact List

Changing Contact Information

To change the information, right-click the contact and choose Edit Profile. The Outlook contact dialog appears. 

Deleting a Contact

Delete contacts from within Outlook. 

Managing Groups

Bria uses the groups that are set up in Outlook. If no groups are set up, all contacts are added to a group called 
“Ungrouped Contacts”. You cannot rename or delete this group. 
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5.4 Using Contacts
Phone or IM the person • Double-click the contact to start a phone call or IM to the person 

(depending on how double-clicking is configured in the contact’s 
profile).

• Drag the contact to the call entry field to start a phone call.

Phone the person Right-click and choose Call. If necessary, click the desired number.

Send an IM Right-click and choose Send Instant Message. See page 29.

You can watch the contact’s 
online status, if the contact has a 
softphone address

See the table on page 43 for the meaning of the online status icons. 

See “Sharing Online Status” on page 40 for information on obtaining online 
status information.
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5.5 Sharing Online Status
You can publish your online status to contacts who have softphone address, and you can set up Bria to view the 
online status of other contacts. Typical online statuses are available, on the phone, busy, and so on. 

Your online status

Online status of other people

This person may be 
logged out
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Sharing Online Status

Watching Others’ Status
To watch a contact’s status, that contact must be tagged:

• If you create a contact by entering details in the Contact Profile, you can click the “See this person’s online 
presence” field in order to share status information. 

• If you are using Outlook as your contact storage, you can share status information by selecting one or more 
contacts and choosing Subscribe to presence. 

• If you created a contact by importing a contact list, you can specify during the import whether you want to 
share presence information. 

When you choose to shared presence information, Bria sends the contact a notification request. The request asks 
that you be able to see that person’s status. If the person allows this request, then the icon beside their name (in 
your Contacts) becomes color coded to specify their status. 

Allowing Other Parties to See your Status (Publishing your Status)
Continuing from above, when the other person allows the notification request, your name is added to their 
contact list. As soon as you are added to their list, a request is sent back to you requesting that they be able to 
see your status. Bria accepts this request automatically, and the other person can now see your status.

Troubleshooting: When You Cannot See the Online Status
If you have an XMPP account, online status information (presence) is always handled through that account. If 
you do not have an XMPP account, it is handled through one of the SIP accounts; see page 49. 

If you do not have an XMPP account, you should not change the account used for presence: choose one account 
when you first set up your SIP accounts. If you switch accounts and then switch again, the presence subscription 
for some contacts will be lost and you will have to set up the subscription again for each contact individually 
(by checking the presence checkbox on the Contact Profile).

Receiving an Online Status Request
Someone who is not one of your contacts may add you as a contact on their end, and may include your SIP 
address or XMPP address. In this case, you receive an Online Status Request. 

The request is handled in one of two ways:
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• If you set up a privacy rule before this person has a chance to contact you, then you will never see this 
request. Bria will automatically reply to the request according to the rule. See page 66.

• If you do not yet have a privacy rule set up for this person or for their domain, this request appears to you as 
an Online Status Request. You must respond to the request:

(If you are using Outlook as your contact storage, clicking Allow opens the Outlook contact dialog; save and 
close the dialog to allow the person to see your online status.)

Option Button Comment Result

Create a new 
contact

Allow This option is selected for you if 
you do not currently have a 
contact with this SIP or XMPP 
address.

Allow the request and create a new contact using this address.
Because you allow the request, you will no longer be bothered by 
requests from this person. In addition, this same request will 
automatically be sent from your Bria to the other person, so that 
you can see their online status.

Update an 
existing contact

Allow This option is selected for you if 
you already have a contact with 
this SIP or XMPP address but 
you were not previously sharing 
your online status with this 
person.

Allow the request and add this address to an existing contact (if 
Bria has found an appropriate match).
Because you allow the request, you will no longer be bothered by 
requests from this person. In addition, this same request will 
automatically be sent from your Bria to the other person, so that 
you can see their online status.

Either option Block Block the request. 
This person will not be able to contact you from this address.

Either option Ignore Ignore the request.
The other person will not be able to see your online status. The 
other person will not be added to your privacy settings. The Online 
Status Request may appear again in this session or a future session.
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Setting your Online Status

Changing your Status
Click the down arrow beside the online status indicator on Bria, and select the desired online status. See below.

Setting up Status Indicators
You can create a custom status indicator: click the down arrow beside the status indicator, and choose Custom 
Message.
 

Indicator Meaning for your Status Meaning for Others’ Status

Available Either:
• You have set your status to this value. 
• Bria has determined that you are logged on but not on the phone or 

idle.

When you have this status, Bria will automatically detect when you 
are idle or on the phone, and change the status to match.

You can contact this person.

Busy You have set your status to this value. Bria will never automatically 
switch you out of this status; you must switch yourself.

You can contact this person.

Away You have set your status to this value. Bria will never automatically 
switch you out of this status; you must switch yourself.

You can contact this person.

On the phone Either:
• You have set your status to this value. In this case, Bria will never 

automatically switch you out of this status; you must switch 
yourself.

• You started a phone call when your status was “Available”. When 
your call finishes, your status reverts to “Available”.

You can contact this person.

Idle You have not moved or clicked the mouse or pressed a keyboard key 
for the Idle period. To set the Idle period see Softphone > Preferences 
> Application.
As soon as you click the mouse or keyboard, your status changes to 
“Available”.

You can contact this person.

Appear offline You have set your status to this value. The other person sees you as 
offline, even though you are actually online. The other person cannot 
tell the difference between this status and you really being offline.

The contact is either not logged on or 
else is not set up to share online 
status. 

No icon Not applicable You are not watching the other 
person’s status.
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Adding Contacts to the Alert List (Buddy Pounces)
You can add a contact to the Alert List in order to request to be notified when the online status of a contact 
changes. 

Right-click the contact or contacts and choose Add to Alert List. The Alert List icon appears beside the contact:

When the contact’s status changes, a notification appears.

Alert List icon

The time at which the 
contact’s status changed

Click to keep the contact on the alert list; the next time the 
contact’s status changes, another notification will appear.
Or leave unchecked to stop receiving notifications.

Click to phone or IM this 
person
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5.6 Privacy
You can control how contacts and other people can contact you by phone or IM, and you can control whether 
your contacts can see your presence information (whether you are online, one the phone, and so on).

You can set up controls in advance or “on the fly” (as phone calls and presence requests come in).

Setting up Controls in Advance
To set up controls in advance, see page 66.

Setting up Controls “on the Fly”

Via the Online Status Request

Another party can send you a presence request, to request that they be able to see your presence, as described on 
page 41.

Your response has the following effect on privacy: 

• If you add the person as a contact, then the ability of that person to phone or IM you is controlled by your 
privacy settings.

• If you allow the person without adding them as a contact, then the ability of that person to phone or IM you 
is controlled by your privacy settings.

• If you block the person, then that person is added to your Blocked List (Softphone > Preferences > 
Privacy). The person will not be able to phone or IM you, and will not see your availability information. 
You can change this blocking by removing the person from the Blocked List, in which case they will then 
be controlled by your privacy settings.

For information on privacy settings and the Blocked List, see page 66. 

From the Contact List or History List

Right-click on the name and choose Block this Person. The person will be added to your Blocked List 
(page 66). The person will not be able to phone or IM you, and will not see your availability information. 

To later unblock this person, right-click on the name and choose Unblock this Person.
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6 Using Other Resources

6.1 History Tab

Managing the Lists of Calls
You can right-click on an entry in a list to:

• Delete the entry.
• Delete all entries in the list.
• Block this person to control whether they can send you phone calls or instant messages, or see your online 

availability. 
• Edit the profile if the entry is a contact.
• Add as contact. The Add a Contact dialog appears. For more information on this dialog, see “Adding a 

Contact using an Existing Address” on page 37.

Phoning from History
You can:

• Right-click on an entry to place a call to this person, using the contact method that was used for this call. 
• You can double-click to place an audio call.
• Place a call to this person and add them to a conference call that is in progress. For more information on 

conference calls, see page 24.

Filter list

Incoming missed call

Incoming call that was 
answered

Outgoing call, either 
attempted or established

Detach the history list
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6.2 Favorites Tab
You can create favorites from your contact list. They will be displayed in both the contact list and in the 
Favorites tab.

Select the desired contacts, then right-click and choose Add to Favorites. 

You can perform nearly all the same actions 
on the contact in Favorites as you can in the 
contact list.

Removes from Favorites but does not remove 
from the contact list

Removes from Favorites and the contact list
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7 Configuring Bria

You can configure Bria in several ways:

• Configure global behavior. See “Configuring Preferences” on page 64.
• Configure the behavior on a per-account basis. See “Configuring Accounts” on page 49.

7.1 Configuring Accounts

Accounts Settings Window
To work with accounts, choose Softphone > Account Settings from the menu. The Account Settings window 
appears, showing all the accounts set up.

Accounts List with One Account 

Make sure the account is enabled
Whether this account is used 
for IM and presence

Indicates the account is 
being used for phone calls
49



CounterPath Corporation
Accounts List with Multiple Accounts

You can:

• Add or remove an account. (You can only add one XMPP account; you can add multiple SIP accounts.)
• Enable one or more accounts. See below for details.
• Set or change account properties. Select the account and click Edit. See the following pages for details. 

Setting up Accounts for Phone Calls
If you have more than one SIP account, set up for phone calls as follows: 

1. Set up the “use for” information: Open the Accounts tab for each SIP account and check the Use For Call 
field if you want to use the account for phone calls.

2. Back on the accounts list, enable the accounts you currently want to use for phone calls. The following 
rules apply:

• When multiple accounts are enabled, you will be able to receive calls on all those accounts.
• You can never place a call on a disabled account. If you place a call that is only valid on the disabled 

account, it will fail with a “Not found” message.
• You can never receive a call on a disabled account. If another party phones you on a number that is only 

known to a disabled account, the call will never appear on your Bria. 

3. Set the Preferred account for calls. Only currently enabled accounts are displayed in the dropdown list.

4. Click Apply. The icons in the Call column are updated: 

The account is the “preferred account”.

The account can be used for phone calls by selecting it on the dashboard (page 15)

The account cannot be used for phone calls.

Typically, set up accounts as instructed by your 
VoIP service provider and enable them all

The functions this account is being used 
for. See below.

This account will be used for calls if Auto Select is used 
(page 15) and there are no dial plan rules for selecting 
the account
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51

Setting the IM/Presence Account
If you have more than one SIP account, set up for IM and presence as follows: 

1. Set up the “use for” information: 

• If you do not have an XMPP account: Open the Accounts tab for the one SIP account you want to use 
for IM and online status (presence) and check the Use for IM/Presence field. 

• If you do have an XMPP account: Do nothing; the Use for IM field is ignored because you will use 
XMPP for IMs and online status (presence).

You should not change the account used for presence: choose one account when you first set up your 
accounts. If you do change the account after initial deployment, see “Troubleshooting: When You Cannot 
See the Online Status” on page 41.

2. Back on the accounts list, make sure you enable the account you want to use for IM and online status.

3. Click Apply. The icons in the IM columns are updated: 

You are using the account for IM and online status. Only one account can have this icon.

The account is not being used for IMs and online status.
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XMPP Account

Table 1: XMPP Account Properties – Account

Field Description
Account name If desired, change the account name to something that is meaningful to you. For example, the 

name of the VoIP service provider.
Protocol Read-only. Always specifies XMPP.

User Details
User ID Typically the account number for the softphone account. For example, kperera. Provided by the 

XMPP service provider.
Domain For example, domainXMPP.com. Provided by the XMPP service provider.
Password Provided by the XMPP service provider.
Display name This name is displayed in the Bria display.

Other parties will see this name when they are connected to you.

Advanced
Port selection Configures the port to use.

If you choose “User selected”, complete the Connect port field. 
Connect port Complete only if Port selection is set to “User selected”
Outbound proxy The value in User ID and in this setting may be used by Bria to compose a valid jid:

• If User ID=bob@ABC.com and Outbound proxy is empty, jid=User ID: bob@ABC.com
• If User ID=bob@ABC.com/home and Outbound proxy is empty, jid=User ID: 

bob@ABC.com
• If User ID=bob@ABC.com and Outbound proxy=XYZ.com, ignore the Outbound proxy; 

User ID=bob@ABC.com
• If User ID=bob@ABC.com and Outbound proxy=IP address or host address, jid=User ID. 

(IP address is used as the outbound proxy).
• If User ID=bob and Outbound proxy=ABC.com, jid=bob@ABC.com.

Resource Optional resource, as specified in RFC 3920. For example “/home”. If this setting is blank and 
the User ID includes a resource, the value from that ID is used. If both are specified, the value 
from this Resource field is used.
If no resource is specified, the XMPP server will assign a temporary resource.

Priority The priority, as per RFC 3921. The default is 0.

Fields with a red asterisk are required
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SIP Account Properties – Account

Table 2: SIP Account Properties – Account

Field Description
Account name If desired, change the account name to something that is meaningful to you. For example, the 

name of the VoIP service provider.
Protocol Read-only. Always specifies SIP.
Use for Call If checked, this account is eligible to be used for phone calls. If unchecked, this account will 

never be used for placing phone calls.
Use for IM/Presence If checked, this account is eligible to be used for IM and online status (presence). If 

unchecked, this account will never be used for IM and online status.
Only one SIP account can have this field checked; if you check it for one account it will 
become unchecked for the currently checked account.

User Details
User ID Typically the account number for the softphone account. For example, kperera. Provided by 

your VoIP service provider.
Domain For example, domainA.com. Provided by your VoIP service provider.
Password Provided by your VoIP service provider.
Display name This name is displayed in the Bria title bar.

Other people will see you as this name.
Authorization name May not be required. If it is required, it will be provided by your VoIP service provider.

Fields with a red asterisk are required
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Domain Proxy
Register with domain and receive 
calls

Check this box if you want to register with your VoIP service provider, so that you can receive 
incoming calls.
Typically, this field is checked. 
This field may be left unchecked when, for example, your level of service does not include the 
ability to receive incoming calls. In that case, turning this field on may cause registration to 
fail (when you close the Account Properties window), meaning that your Bria cannot register 
with your VoIP service provider.

Send outbound via Choose the setting specified by your VoIP service provider: 
• Domain: If your VoIP service provider requires that traffic be directed to proxies that are 

discovered via the domain.
• Proxy Address: If your VoIP service provider has an outbound proxy address and requires 

that you provide the address to Bria. For the address enter a domain name (for example, 
domain.com) or an IP address (for example, 123.456.789.012). 

If you are using Bria in a test lab, it is possible that neither of these settings is suitable; see 
page 63 for a third way to direct traffic.

Dial Plan Information about the syntax of the numbers used by this VoIP service provider. 
Provided by the service provider. The default plan is:
#1\a\a.T;match=1;prestrip=2;
For information on determining whether you need to modify the default dial plan, see 
page 88. 

Table 2: SIP Account Properties – Account

Field Description
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SIP Account Properties – Voicemail

These settings let you set up to interact with your VoIP service provider’s voicemail service. They also let you 
configure Bria to forward calls in several situations, independent of your VoIP service provider’s voicemail 
service.
Your service provider may provide the ability to set up for voicemail outside of Bria, for example, by phoning a 
softphone address and following the voice prompts, or by accessing a website. 
Check with your service provider to determine if another setup mechanism is available. If so, check what the 
settings are in that setup, and make sure you enter compatible information in Bria.
In particular, if your service provider has a mechanism for call forwarding, find out if you should leave the 
Forwarding settings on this Voicemail tab blank.
 

Table 3: SIP Account Properties – Voicemail

Field Description
Check for voicemail Set the checkbox in one of these ways:

• Check the box if Bria must subscribe to be notified when there is a voicemail for 
you. In other words, to configure for “subscribe for message waiting”.

• Clear the checkbox if the service provider’s voicemail server sends notifications 
without Bria subscribing. In other words, to configure for “implicit subscription”.

• Clear the checkbox if the service provider does not support voicemail. 

Check with your VoIP service provider for the correct configuration.

Voicemail is offered by your VoIP service provider; it is not part of Bria. Contact your 
service provider for information on using voicemail.

Number to dial for checking voicemail Optional, but complete this field only if your VoIP 
service includes voicemail. 
• Completing this field activates the voicemail icon on 

the softphone. When you click this icon, Bria will dial 
this number. You will be connected to your service 
provider’s voicemail and can listen to your messages. 

• If you leave this field empty, then this icon will not 
work; you will have to manually dial this number in 
order to connect to voicemail.

Enter the number or SIP address provided by your VoIP service provider.
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Number for sending calls to voicemail Complete only if your VoIP service includes voicemail. Optional, but you must 
complete it if you check “Send calls to voicemail if unanswered”.
This is the number that incoming calls will be forwarded to if they are unanswered after 
the specified interval (below).
If you leave this field empty, then Bria will never forward calls to your service 
providers’ voicemail. However, most VoIP service providers have their own mechanism 
for sending unanswered phone calls to voicemail. So leaving this field blank does not 
mean that forward-to-voicemail does not work. 
Enter the number provided by your VoIP service provider.

Send calls to voicemail if unanswered Complete only if your VoIP service includes voicemail.
To send to voicemail after the specified number of seconds. 
Your service provider may also provide a similar feature that is set up outside of Bria. If 
so, make sure you do not enter competing information in Bria and in the service 
provider’s user interface. For example, if you turn off this field, make sure the same 
feature at your service provider is also turned off. Otherwise, all your calls will continue 
to be forwarded.

Always forward to this address You can use this feature even if your VoIP service does not include voicemail.
To always forward phone calls, click the box and enter the address to forward to. Phone 
calls received on other accounts (if you have them) are not affected by enabling this 
field. 
Always forward works only when Bria is running and only if your VoIP service 
provider supports redirect.

When on the phone, forward to You can use this feature even if your VoIP service does not include voicemail.
To forward only when you are on another phone call, click the box and enter the address 
to forward to. Phone calls received on other accounts (if you have them) are not affected 
by enabling this field. 
Always forward works only when Bria is running and only if your VoIP service 
provider supports redirect.
Your service provider may provide a similar feature that is set up outside of Bria. If so, 
make sure you do not enter competing information in Bria and in the service provider’s 
user interface. For example, if you turn off this field, make sure the same feature at your 
service provider is also turned off.

Table 3: SIP Account Properties – Voicemail

Field Description
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SIP Account Properties – Topology

Table 4: SIP Account Properties – Topology

Field Description
Firewall traversal 
mode

Leave the default. Or if you have problems making phone calls, contact your VoIP service provider for 
information on their firewall traversal solution.

Range of ports used 
on local computer

The appropriate setting depends on your computer setup:
• Checked: If your computer is behind a restrictive firewall that only allows specific port ranges to be 

used. Enter the range of ports to use for your SIP account. (You must also open those ports on your 
firewall; refer to applicable firewall documentation for information.)

• Unchecked: If your computer is not behind a restrictive firewall.   
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SIP Account Properties – Presence

Presence allows other softphone users to see your online status, and also allows you to see the online status of 
others. 

This tab lets you set up to share presence information with contacts. (Note that you do not have to set up to 
share presence information on an XMPP account.) 

Table 5: SIP Account Properties – Presence

Field Description

Presence
Mode Choose the setting specified by your VoIP service provider:

• Disabled: Presence is not supported.
• Presence agent. 
• Peer-to-peer.

Poll time Enter the value specified by your VoIP service provider. 
Refresh interval Enter the value specified by your VoIP service provider. 

Workgroup
Workgroup address Typically, workgroups are used only in enterprises and are set up by the system 

administrator.
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SIP Account Properties – Storage

These settings let you set up a remote storage system for the buddy list for this SIP account. (Note that the 
buddy list for an XMPP account is always stored on the XMPP server; no configuration is required).
If you plan to use your Microsoft Outlook address book from within Bria (page 79), your buddy list must be 
stored locally.

Table 6: SIP Account Properties – Storage

Field Description
Storage method The storage method to be used for the buddy list and presence rules. The file can be stored 

locally or both locally and on a remote computer.

Server Settings (not used for “Local”)
Use SIP credentials Check this box to use the username and password from your SIP account in order to log into 

the storage server.
Otherwise, uncheck this box and complete the Username and Password fields.

Use alternative server credentials Check this box to use specific credentials. Enter data for connecting to the server.
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SIP Account Properties – Transport

You can set up Bria for the type of security (encryption) you want for incoming and outgoing calls.
Bria supports:
• Signaling encryption using TLS
• Media encryption using SRTP.

Setting up for Security outside of Bria
When using TLS, you must have the root certificate that signs the proxy's chain of certificates. In most cases, 
the root certification will already be installed. Procedures for the exchange of certificates are outside the scope 
of this documentation. The certificates must be stored on the Bria computer, in the root certificate store.
Setting up the root certificate on your computer ensures that the connection to the proxy is TLS secure (the first 
hop). Any proxy in the chain (between you and the caller) that does not support TLS may cause an insecure link 
in the chain. Therefore, if the other party is outside your domain, you cannot be completely sure that the call is 
secured at the signaling level, which means that you cannot be sure that it is secured at the media level.

Table 7: SIP Account Properties – Security

Field Description
Signaling Transport Contact your VoIP service provider to identify the types of transport that are supported. 

Then choose a supported transport:
• Automatic: Bria sets up the transport based on the capabilities of the network and the 

Bria computer. Choose this option if you do not care which transport is used.
• TCP: This transport provides no signaling security. 
• UDP: This transport provides no signaling security. 
• TLS: Choose this option to request signaling encryption or both signaling and media 

encryption.
Encryption See the description below for more information.
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Setting up for Security within Bria
The options for media encryption are described in the following table.

Table 8: Security Options

Option How Outgoing Calls are Handled How Incoming Calls Are Handled
Make and accept only 
encrypted calls

Bria will place all calls with TLS. The call INVITE 
will specify SRTP media encryption. 
If the correct certificates are not in place or if the 
other party does not accept encrypted calls, the call 
will fail.

Bria will only accept INVITEs that are for 
encrypted calls. 
If Bria receives a call INVITE that is not 
encrypted, the call will be rejected.

Do not allow encrypted 
call

Bria will place only unencrypted calls.
If the other party does not accept unencrypted 
calls, the call will fail.

Bria will only accept INVITEs that are for 
unencrypted calls. 

If Bria receives a call INVITE that is encrypted, the 
call will be rejected.
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SIP Account Properties – Advanced

Table 9: SIP Account Properties – Advanced

Field Description

Register Settings
Reregister every The time interval between Bria’s attempts to reregister in order to refresh the account registration 

with the VoIP service provider for this account. A value of zero means not to reregister after the 
initial registration.
This value is placed in the “Expires” header field of the REGISTER message.

Minimum time If the reregistration fails, Bria will wait this amount of time, then attempt to reregister. If the 
second attempt fails, Bria will wait twice this time and try again, then four times this time, and so 
on, until reregistration succeeds.

Maximum time This is the maximum wait time between attempts to reregister. Once this maximum is reached, 
Bria will wait this time for all subsequent attempts.
For example, the min. time is 20 secs, the maximum time is 120 secs. Bria will attempt to 
reregister as follows:
• Wait 20 secs.
• Attempt to connect. 
• If fail, wait 40 secs.
• Attempt to connect.
• If fail, wait 80 secs.
• Attempt to connect.
• If fail, wait 120 secs (the maximum)
• Attempt to connect.
• If fail, wait 120 secs, and so on.
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Timers
Enable session timers
Default session time

A session timer is a mechanism to detect whether a call session is still active from the signaling 
point of view. When the timer expires, a refresh is sent from one party to the other. The timer is 
then reset.
• Turn on to enable session timer. Enter a value in Default session time. 
• Turn off to disable session timer; refreshes will never be sent.

Session timer preference This field specifies your preference for which party should send the refresh. The preference is not 
a guarantee that the refresh will be performed by the specified party. The choices are:
• None: No preference.
• Local refreshes: Your computer sends.
• Remote refreshes: The other party sends.
• UAC refreshes: The user agent client (the party that initiated establishment of the 

communications) sends.
• UAS refreshes: The user agent server (the other party) sends.

Hold Method Change this setting only if your VoIP service provider advises you to do so.
Send SIP keep-alives Typically on, to instruct Bria to send SIP keep-alive messages in order to maintain a “pinhole” 

through your firewall for SIP messaging.
Use rport Typically on.
Send outgoing request 
directly to target 

When checked, requests with a complete URI (user@ABC.com) go to ABC.com and the “Send 
outbound via” field on the Account tab (page 52) is ignored.
If you check this field, make sure you also set “Send outbound via” (on Accounts > Account) to 
“Domain”.
Typically off. This field is intended for test labs and may cause problems in a NAT environment.

Table 9: SIP Account Properties – Advanced

Field Description
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7.2 Configuring Preferences
Choose Softphone > Preferences. The Preferences window appears. 

The Preferences panels let you control the way that you work with Bria. 

Preferences – Application

This panel lets you set your preferences for general GUI behavior and lets you set up for login.

Login Options
Login is typically used only in enterprises. You should not enable login.

Button Defaults
This feature lets you control the action performed for two buttons:

• The green Call button at the top of the phone. For example, you can configure the button so that it makes a 
video call instead of an audio call.

• The transfer button. For example, you can configure the button so that it initiates unattended (call now) 
transfer instead of an attended (call first) transfer.
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Preferences – Alerts & Sounds

The tabs on this panel let you control the Call Alerts box and lets you assign sounds. 

Alerts

You can control whether the Call Alert box is displayed in different situations. 

You can also control how you are alerted to an incoming IM: either with a small IM Alert box or with the IM 
window itself.

Sounds

You can assign specific sounds to a variety of actions or “events”.

1. Select the Enable sounds check box and select the check boxes for each desired event, or clear the Enable 
sounds check box to disable all sounds.

2. You can change the sound for each event: select the individual event. The value in Sound preference will 
change. Select the desired sound.

You can import sounds; these will be added to the list of sounds you can choose from when assigning a sound to 
an event.
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Preferences – Privacy
You can control how contacts and other people can contact you by phone or IM, and you can control whether 
your contacts can see your presence information (whether you are online, on the phone, and so on).

General Tab

In “Global Contact Settings”, choose one option. If you choose “Allow only”, then all contacts will be able to 
contact you unless they or their domain are in the Blocked list (below).

The “Blocked” section is optional. It lets you enter addresses and domains that will be prevented contacting 
you.

You can add and remove entries from the blocked lists. In addition, entries are automatically added to this list 
when you block someone “on the fly” (page 45).

Corporate Tab

If you enter a domain in this list, people in that domain will automatically be allowed to see your online status. 
You will no longer see Presence Request dialogs from these people in this domain. 
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Preferences – Devices

Bria automatically detects devices at each startup, and selects the most appropriate device for each purpose. If 
you do not like this selection, you can override it on this panel.

If you override a selection, it will apply the next time you start Bria, unless the device is no longer available, in 
which case Bria will again select the device to use.

Table 10: Preferences – Devices

Field Description

Headset Mode

Speaker 
Microphone 

Change these fields only if you want to override the devices that Bria automatically selected.
In both these fields, select the headset you are using.
The headset is the device that is usually used for audio out (the sound you hear) and audio in 
(recording your voice). The only situation in which the headset is not used is when the Speaker 
Phone button on the dialpad is pressed. 
Therefore, unless you will always be using Bria in speakerphone mode, you must make a selection 
here.
Select the headset in both the Speaker device field and Microphone device field.

HID Device If the selected headset device is a HID-compliant device, this field specifies that device. You can 
click Setup in order to assign functions to the device. For example, you can set the green button so 
that it answers an incoming call.

Zero-touch device 
configuration

Typically, leave on. When device configuration is on, if you change your audio or video device, 
Bria will automatically detect the new device and start using it.

Also ring PC speaker Click on or off, to suit your preference.

Test Devices For information on the Test Devices button, see page 83.
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Speakerphone Mode

Speaker Change this field only if you want to override the devices that Bria automatically selected.
Make the appropriate choice:
• Select the device that you want to use for audio out (the sound you hear) when the Speaker 

Phone button is pressed. Make sure you select a speaker device (not the headset).
• Select None if you do not have a speaker phone. The Speaker Phone button on the dialpad is 

disabled.

Microphone Change this field only if you want to override the devices that Bria automatically selected.
Make the appropriate choice:
• Select the device that you want to use for audio in (recording your voice) when the Speaker 

Phone button is pressed. 

It can be any microphone: it does not have to be the microphone on the device you specified as 
the speaker device. For example, it can be the microphone on your camera. 

• Select None if you do not have a speaker phone. The Speaker Phone button on the dialpad is 
disabled.

HID Device If the selected speakerphone device is a HID-compliant device, this field specifies that device. You 
can click Setup in order to assign functions to the device. For example, you can set the green button 
so that it answers an incoming call.
See below for details.
(If the speakerphone device is the same as the headset device and you have already configured the 
device, there is no need to click Setup again.)

Other Device

Ring On Change this field only if you want to override the devices that Bria automatically selected.
The device where you want to hear the phone ringing: the headset, the speakerphone, or none.

Camera This field appears only on versions of Bria that include video functionality.
Change this field only if you want to override the devices that Bria automatically selected.
Select the camera model.

Deskphone If you are set up with a deskphone, click to configure the URI of your deskphone, in order to work 
in deskphone mode. See page 27.

Table 10: Preferences – Devices

Field Description
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HID Devices: USB Device Button Setup
You can assign functions to a HID-compliant device. For example, you can set the green button so that it 
answers an incoming call.
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Preferences – Shortcut Keys
You can enable shortcut keys to several functions. 

Customizing the Shortcut Key Combinations

You can change the default key combinations.

1. Make sure Enable shortcut keys is checked and the action you want to change is enabled..

2. Select an Action and click Edit. The Edit Shortcut Key dialog appears.

3. Make sure there is a check in the keys you want to use. You must turn on 
at least two keys.

4. Type the desired letter or number in the field. For example, the following 
creates the shortcut combination Shift-Alt-U.

The following rules apply:

• You cannot override standard Microsoft Windows combinations such as Ctrl-Alt-Delete.
• The shortcut applies when Bria is running, regardless of the application that is in focus. For example, if Bria 

is running but another application has focus, pressing Ctrl-Alt-Shift-A will answer an incoming call.
• If another application has the same shortcut combination, then which application was started later has 

control over that combination.
• If the shortcut is not valid at a particular moment, then it has no effect. For example, pressing Ctrl-Alt-

Shift-A has no effect if there is no incoming call in Bria.

Click to enable shortcut 
keys.

Then make sure the 
individual actions are 
enabled
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Preferences – Network

Table 11: Preferences – Network

Field Description

Network Connection Speed Select the type of network connection for your computer.
The sliders move to show the bitrate that will be used for sending and receiving. These rates are 
typical rates for the selected configuration.
If you know that your computer and network can handle a faster sending speed, click Custom 
and move the slider.
It is recommended that you not change the receiving speed.
You will know that you have set the sending speed too high if:
• The remote video shows black areas or is slow or jerky.
• The remote audio is garbled.

You will know that you have set the sending speed too low if the audio is good but the video is of 
poor quality (grainy).
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Preferences – Audio Codecs

This panel shows all the codecs that are included in the retail version of Bria. You can enable or disable codecs 
as desired. 

With only one codec enabled, all calls made will use that codec. With more than one codec enabled, Bria 
automatically chooses the best codec based on the other party’s capability, the available bandwidth, and 
network conditions.

You cannot change the properties of any codecs.

About Codecs
Audio codecs describe the format by which audio streams are compressed for transmission over networks. 
Codecs can be categorized as either narrowband or wideband:

• Narrowband codecs work with low bandwidth such as a dialup internet connection. These codecs have a 
sampling rate of 8 kHz.

• Wideband codecs work with high bandwidths and result in better audio quality. However, they do not work 
with PSTN. These codecs have a sampling rate of 16 kHz.
72



Bria 3 for Windows User Guide – Retail Deployments
Supported Codecs
Codec Narrowband Wideband Royalty-bearing Included in Bria

AMR Wideband (G.722.2)

Broadvoice-32

Broadvoice-32 FEC

DVI4

DVI4 Wideband

EVRC

G.711aLaw *

G.711uLaw *

G.722

G.723

G.726

G.729 *

GSM

iLBC

L16 PCM Wideband

Speex

Speex FEC

Speex Wideband

Speex Wideband FEC

* Generally, at least one of these codecs must be enabled in order to place a PSTN (land line) call. 
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Preferences – Video Codecs

Video codecs describe the format by which video streams are compressed for transmission over networks. Some 
codecs require less bandwidth than others, but may result in lower video quality.

You can enable or disable codecs as desired. You may decide to disable a codec even though your VoIP service 
provider supports it.

With only one codec enabled, all calls made will use that particular compression format. With more than one 
codec enabled, Bria automatically chooses the best codec based on the other party’s capability, the available 
bandwidth, and network conditions. 

You cannot change the properties of any codecs.

Supported Codecs
   

Codec Royalty-bearing Included in Bria

H.263

H.263+ 1998

H.264 (unified)
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Preferences – Quality of Service

The Quality of Service panel lets you request a specific transport service for audio, video and signaling 
traffic.This service is through DSCP (also known as ToS). In a network that has the default configuration, the 
recommended value for audio is 46, because “46” is the standard marking for audio.

There are two types of services. The service to use depends on what your internet service provider supports:

• GQoS, which is available for audio and video.
• DSCP (also known as ToS), which is available for audio, video and signaling.

In a network that has the default configuration, the recommended value for audio is 46, because “46” is the 
standard marking for audio.

Bria supports 802.1p QoS packet tagging. If you set up for QoS, Bria will include the specified information in 
the packets that it sends to the network provider. Whether the packet is delivered with the specified service 
depends on whether your broadband router and the network provider between you and the other party supports 
multiple transport services. In other words, whether each network provider reads the QoS information and 
prioritizes packet delivery based on the requested service. 

These fields appear only 
on versions of Bria that 
include video.
75



CounterPath Corporation
Preferences – Media Quality

Video Quality

Enable this option Check or uncheck to flip the video image.

Resolution – Limit available 
resolution

If you enable this field, Bria will determine the maximum quality that your computer can handle 
and will disable unapplicable options in the list of possible resolutions

Resolution Leave at standard, or change the size as follows:
• Set it to high if you have a good camera and a computer with a fast CPU. You will know that 

you have set the size too large if:

Your computer slows down (the video is using too much CPU)
The video shows black areas or is slow or jerky.

• Typically set it to low only in special situations, for example, when using wi-fi in a hotel. You 
will know that you have set the size too small if the video is fuzzy.

Audio Quality

Reduce echos Turning this feature on improves sound quality. This feature is typically on.

Reduce background noise Automatically attempts to remove background noise.
Typically on for the speakerphone.

Automatic gain control This feature is typically on.

Preserve bandwidth When this feature is on, Bria stops sending audio when you are not talking.
When this feature is off, Bria always sends audio, which uses more bandwidth but may result in 
better call quality.
Typically off. However, if you are using a slow (dial-up or ISDN) connection, you may want to 
turn it on. 

Volume Control Choose the setting that suits your setup.
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Preferences – Directory

Typically, directories are used only in enterprises and are set up by the system administrator.
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Preferences – Call Automation

These settings let you configure how you want auto answer to handle incoming calls, when Auto Answer is 
enabled. (To enable Auto Answer, see page 18).
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Preferences – Contact Storage

Fields when “Local” Is Selected
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Fields when “Outlook Personal Contacts” Is Selected

These settings let you set up a remote storage system for your contact list. The contact list holds general 
information for contacts and is automatically loaded at startup, even if no accounts are enabled.
Remote storage can be via WebDAV, XCAP or Microsoft Outlook.
• If you set storage to Local, the contact list is stored only on your computer.
• If you set storage to WebDAV or XCAP, the contact list is stored remotely via the specified method and is 

also stored locally, on your computer.
• If you set storage to Outlook Personal Contacts, the contact list is not stored locally. Instead, you are 

actually using your Outlook contacts from within Bria. When you start Bria, contacts are fetched from 
Outlook. When you add (including adding by importing) or modify a contact in Bria, the contact is actually 
saved in Outlook. 

Table 12: SIP Account Properties – Storage

Field Description
Storage method The storage method to be used for the Contact list file. The choices are:

• Local
• WebDAV
• XCAP
• Outlook. 

If you choose an option other than Local, you must provide more information.

WebDAV Settings 
Username and password The user name and password to log into the storage server.
Root URL URL of an appropriate root folder on the remote server. The factory setting is https://

webdav.$domain$/webdav/$username$/
WebDAV poll time  The time that elapses between polling for new contact data from the remote server.

The factory setting is 600.
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XCAP Settings 
Username and password The user name and password to log into the storage server.
Root URL URL of an appropriate root folder on the remote server. The factory setting is https://

xcap.$domain$/xcap/$username$/

Outlook Settings
Outlook profile The profile to use
Profile password The password for the selected profile
Field to use The field where softphone addresses are stored in Outlook contacts. This mapping is used as 

follows:
• If you use a SIP account for IM and presence, then when a Bria contact is created from the 

Outlook contact, the Bria Softphone fields and IM fields (viewable on the contact flyout) will 
be populated with the data from the mapped Outlook field. 

Bria will assume that this data is a SIP address and can be used to place phone calls and send 
IMs and that it could be subscribed to for online status information. 

• If you use an XMPP account for IM and presence, then when a Bria contact is created from 
the Outlook contact, the Bria Softphone field (viewable on the contact flyout) will be 
populated with the data from the mapped Outlook field. 

Bria will assume that this data is a SIP address and can be used to place phone calls. 

Table 12: SIP Account Properties – Storage

Field Description
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Preferences – Advanced

Table 13: Preferences – Advanced

Field Description

DTMF You may need to change the DTMF configuration if you cannot interact with interactive 
voice response systems (auto attendants, voice-activated menus, and so on).
Contact your VoIP service provider for the correct setting.

RTP This timer controls how calls are disconnected when Bria determines that there is a 
problem with the call and the other party has probably disappeared (assuming that you 
have not yourself detected the problem and hung up manually).
Typically, the timer is enabled. It is recommended that you not disable it.
You can change the length of the timer, but do not set it to less than 30 seconds.

Recording folder The folder where files for recording of phone calls will be saved.

File transfer folder The folder where received files will be saved. 

Web Page Tabs You can set up a web page as a new tab in the Resources panel; it will appear alongside   
Contacts, History and so on.
Enter the web address and a name (this name will be appear in the tab). Enter a checkbox 
to create the tab. 
At any time, you can clear the checkbox to remove the tab from the Resources panel.
You can also simply show or hide the tab from the View menu in the Bria menu.
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A Troubleshooting
Choose Help > Troubleshooting to display the Troubleshooting window. 

Testing Audio and Video Devices
You can verify that your microphone, speakers and camera are working and can set the volume to a comfortable 
level without having to actually place a phone call.
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Testing the Network Connection
You can verify that you are successfully connected to the network. 
84



Bria 3 for Windows User Guide – Retail Deployments
Testing Audio Quality
While you are on a phone call, you can test the quality of the audio. Note that to perform a valid test, you should 
be on an established call (not a call attempt). 
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Diagnostics
Only use this panel if instructed to do so by your support representative at your VoIP service provider.

To start logging Bria activity and send a logging report to customer support:

1. Click Start Logging. The first Diagnostics Logging window appears.

2. Select the problem you are experiencing and click Start Logging. 

3. On the second Diagnostics Logging screen, click Finish. Logging will start.

4. Perform the actions you want to capture; for example, attempt to make a phone call.

5. When done, choose Help > Troubleshooting > Diagnostics again and click Send Report. Select the report 
and send it.

6. When the report has been sent, click Stop Logging. Click Done to close the Troubleshooting window.
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B Application Hot Keys
Function Keyboard Shortcut

Decline an incoming call Ctrl - D

Redial the last dialed number Ctrl - R
or Ctrl - R then Enter

End the call
End the conference call (hang up on all 
participants)

Ctrl - E

Hold or resume the call when the focus is on 
this call panel

Ctrl - H

Mute when the focus is on this call panel Ctrl - M
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C Dial Plan
When a call attempt is made, the call input (what you type, select or drag onto the call entry field) is processed 
to select the SIP account to use and to modify the input if that is required to ensure that the call gets placed 
successfully. This ability to select an account and modify the input relies on the existence of a “dial plan” for 
each account.

Do You Need to Read this Information?
You do not have to read this dial plan information if the default dial plan behavior (below) is acceptable.

If you want to be able to place calls on a specific account without including the account prefix, then you must 
create a dial plan for one or more accounts.

The default dial plan is:

#n\a\a.T;match=1;prestrip=2;

where #n is the account prefix (#1 for the first account in the list (proxy0), #2 for the second account (proxy1), 
and so on).

If the input is the account prefix and the number, then the Account for this dial plan is selected. The account 
prefixed is stripped from the number before the call is placed.

If all Accounts use this dial plan, then the behavior is as follows: if the input includes the account, then that 
account is used. In other words, you can force selection of a specific account by including the account prefix. If 
the input does not include #n, then the default account is used.

Processing of Phone Numbers when a Call is Placed
When a phone call is placed, the input (the phone number or SIP address) is processed as follows:

• Cleanup: Input is cleaned up by removing spaces, dashes, open brackets, and close brackets. 
• Matching: The input is compared to the patterns defined by the dial plan for each enabled account. Each 

account has one dial plan, and each dial plan has one or more patterns.
When a match is found between the input and the pattern, the account that this pattern belongs to is selected 
and the transformation for this pattern is performed.

If no match is found, the default account is selected and no transformation is performed.

For details on matching see “How the Input Is Processed” on page 91.

• Transformation: The selected transformation is performed.
• Then the call is placed using the transformed input. 
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C.1 Dial Plan Syntax
In Bria, the dial plan establishes the expected patterns of characters for a telephone number or softphone 
address, and allows for modification (transformation) of input based on the match to a pattern. The dial plan has 
the following syntax:

pattern[|pattern];match=1;<transformation>=<value>;[match=2;
<transformation>=<value>;]

Where:

• Items in [ ] are optional. 
• Pattern: the pattern that will be matched. One or more patterns. Each pattern is separated by a | pipe. The 

pipe is optional after the last pattern. Each pattern is implicitly numbered, starting from 1.
• Match; Transformation: A pair that identifies the pattern number to compare with the input, and the 

transformation to perform on the input when a match is obtained. The transformation is optional (meaning 
that if there is no transformation for a pattern, then the input that matches this pattern is not transformed). 
One or more pairs.
“match=” is a literal. “n” identifies the pattern. “transformation=” is replaced by a keyword, see below. 
“value” is replaced by a value.

Spaces are allowed only in the <value> items. 

Example
\a\a.T|xxxxxxxxxx;match=1;prestrip=2;match=2;pre=8;

where:

• \a\a.Tis the first pattern.
• xxxxxxxxxx;is the second pattern.
• match=1;prestrip=2;is the first match-transformation pair.
• match=2;pre=8;is the second match-transformation pair.
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Pattern

Valid Content
The content for a pattern follows the digit map rules of RFC 2705, supplemented by the rules for regular 
expressions. Where there is an overlap between the digit map and regular expression rules, the digit map rules 
apply. For this reason, there are some special cases, included in the table below.

The following table describes the most common elements. As mentioned, all regular expression elements are 
supported.

Some elements use the back slash \ character. If you are defining pattern a via remote provisioning (that is, in an 
HTTP response), you must enter two backslashes, because the Bria provisioning software interprets one 
backslash as an escape key. 

Timers
There are two timers:

• T timer is 4 seconds.
• The long timer is 20 seconds.

These timers are used in input comparison, as described in “How the Input Is Processed” on page 91.

Element Origin Description

0 1 2 3 4 5 6 7 8 9 Literals Literal digits, used as is. 

# * a to z Literals Literal characters, used as is. Special cases: 
• The literal x character is represented by \x.
• The literal t character is represented by \t.

x Digit map rules Wildcard for any single digit, 0 to 9. 

\a Regular 
expression rules

Wildcard for any single alphanumeric character.

[digit-digit] Regular 
expression rules

A digit within the specified range.

[character-
character]

Regular 
expression rules

A character within the specified range.

[digit1, digit2, 
digit3]

Regular 
expression rules

One of the characters in the collection.

. Digit map rules Repeat the last element 0 or more times. For example, xxxx. means repeat the last x 0 or 
more times, which means this pattern matches three or more digits (not four or more 
digits)! Use of this element results in a pattern with “minimum requirements”. 

T Digit map rules A timeout period will take place before automatic dialing starts.
The T timer forces Bria to wait after a match is made. This timer should always be 
included in these situations:
• Any pattern that uses the . (dot). For example, if the pattern is xxxx. then adding a 

timer lets you type three or more digits. If there is no timer, then as soon as you type 
three digits, Bria makes the match as soon as you type three digits. 

• Any dial plan that has two patterns that are similar in elements but different in length. 
For example, if one pattern is xxx and the other pattern is xxxxxxx, then adding the 
timer lets you continue typing past three digits, in order to get a match on the second 
pattern.

In this situation, the T timer should be included in the shorter pattern. 
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Transformation Keywords

Order of Transformations
These transformations are always performed in the following order (the order in which the transformations are 
entered in the dial plan is not significant):

prestrip  >  poststrip  >  pre >  post  >  replace

C.2 How the Input Is Processed

Comparing Input to the Dial Plan Patterns
The input is compared to each dial plan in turn, starting with the first listed account. The process is slightly 
different depending on how the call is placed:

• If the input was dragged or selected, then the entire input is compared to each dial plan. If a complete match 
is found, then that account is selected and the associated transformation is performed. If no match is found, 
the default account is selected and no transformation is performed. 

• If you are typing the input, the digits are compared one by one as they are entered. The comparison will 
result in one of the types of matches described in the table below.

It is possible for the same input to get matched to different dial plans depending on whether the input is entered 
on the fly or dragged. It is important to keep this in mind when designing dial plan patterns. 

Results of the Comparison

Keyword Description

prestrip Strip the first n characters from the input before 
placing the call.

poststrip Remove n number of characters from the end of 
the input before placing the call.

pre Add the specified account prefix to the input 
before placing the call.

post Attach the specified postfix to the input before 
placing the call.

replace Replaces the input with the specified string 
before placing the call.

Type of Match Conditions Result if You Press 
Enter or Dial Result if You Stop Typing

Partial match The characters typed so far follow the pattern but 
there are not yet enough characters for a pending 
or complete match.

The default account is 
selected. No transformation 
is performed.

If you stop typing for the long 
timer length (20 seconds), then 
the default account is selected. 
No transformation is 
performed on the characters 
typed so far.
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Pending match • The pattern has no . (dot) but does have the T 
timer. There is a perfect match.

• The pattern has a . (dot) and the T timer. The 
minimum requirements are met.

This pattern's account is 
selected and the 
transformation is 
performed.

If the T timer expires, this 
pattern's account is selected 
and the transformation is 
performed.

Complete match • The pattern has no . (dot) and no T timer. 
There is a perfect match.

• The pattern has a . (dot) but does not have the 
T timer. The minimum requirements are met.

This pattern's account is 
selected and the associated 
transformation is 
performed.

This pattern's account is 
selected and the associated 
transformation is performed.

No match The characters typed do not match the patterns 
for any dial plan.

The default account is 
selected and no 
transformation is 
performed.

Nothing happens even after the 
T timer and long timer have 
expired.

Type of Match Conditions Result if You Press 
Enter or Dial Result if You Stop Typing
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C.3 Examples

Example 1
\a\a.T|xxxxxxx.T;match=2;pre="9"

This simple example shows how to differentiate between a PSTN number and a softphone address, and how to 
add a “9” dialing prefix only to the PSTN number. 

Example 2
3xxT|1xxxxxxxxxx|[2-9]xxxxxxxxx|+x.T;match=2;pre="9";
match=3;pre="91";match=4;prestrip=1;pre="9011"

Example 3
#1xxxxxxxT|#19xxxxxxx|xxxxxxxT|9xxxxxxx|;match=1;prestrip=2;pre=9;match=2;
prestrip=2;match=3;pre=9;

This example assumes that the dial plan belongs to the first account. 

The dial plan is slightly trivial, because it does not cover all the situations that a dial plan should be designed for 
(local calls, long-distance calls, international calls, and so on for the locale). 

However, the example does illustrate two ideas:

3xxT The first pattern is any three-digit number beginning with 3. No transformation. The 
assumption is that this is an internal extension. The timer forces Bria to wait after detecting a 
three-digit number beginning with 3, in case you are actually dialing a local call starting with 
3. 

1xxxxxxxxxx The second pattern is any eleven-digit number beginning with 1. Prefix with 9 and dial as is. 
The assumption is that this is a long-distance PSTN call within North America (within North 
America, all long-distance calls start with 1).

[2-9]xxxxxxxxx The third pattern is any ten-digit number beginning with a number other than 1. The 
assumption is that this is a local PSTN call within a ten-digit dialing zone. 

+x.T; The fourth pattern is a number of any length that begins with +, to indicate an international 
PSTN call from North America. Delete the +, prefix with 9011 (011 is the number to access 
an international line from North America).

match=2;pre="9"; For the second pattern, prefix 9 to access an outside line.

match=3;pre="91"; For the third pattern, prefix 9 and 1 to access an outside line and enter the long-distance code.

match=4;prestrip=1;pre="9011" For the fourth pattern, remove the + and prefix 9011 to access an outside line and enter the 
international code.

#1xxxxxxxT The pattern is an account prefix followed by seven digits. The timer forces Bria to wait to 
allow a match to the second pattern. The #1 is stripped off and 9 is prepended to access an 
outside line.

#19xxxxxxx The pattern is an account prefix followed by a 9 and seven digits. The #1 is stripped off.

xxxxxxxT The pattern is seven digits. The timer forces Bria to wait to allow matching to the fourth 
pattern. 9 is prepended to access an outside line.

9xxxxxxx The pattern is a 9 and seven digits. The input is not transformed.
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• Handling of the account prefix (#1), if you are upgrading from Bria 1.1 and are accustomed to entering the 
account number. 
Use of # to identify the account is now deprecated. The dial plan should be capable of determining the 
account to use for this number. However, since users may still be in the habit of entering the account prefix, 
you may want to include this pattern to handle such a scenario.

• Distinguishing between a local seven-digit call in which 9 is not dialed (to access an outside line) and one 
in which 9 is dialed to access an outside line. 
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D Contact List Headings
Following is a list of all the headings that are used in the Bria contact list. This list can be useful when 
formatting a contact list in order to import it into Bria. For details, see “Importing Contacts” on page 34
The same headings are used for both Bria for Mac and Bria for Windows.

uri

display-name

entry_id

given_name

surname

email_address

email_addressn, where n is 2 to 6

sip_address

sip_addressn, where n is 2 to 6

business_number

business_numbern, where n is 2 to 6

mobile_number

mobile_numbern, where n is 2 to 6

home_number

home_numbern, where n is 2 to 6

fax_number

fax_numbern, where n is 2 to 6

groups

comment

postal_address

default_address

default_address_type

sms_addresss

custom_fields

custom_fieldsn, where n is 2 to 4
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E Other Ways to Run Bria 

E.1 From a Hyperlink
You can attach a hyperlink to a phone number or softphone address that, when clicked, starts Bria and dials the 
number. Attach a hyperlink with this format:

<a href="sip:<address or number>">dial <address or number></a>

For example:

<a href="sip:kperera@domainA.com">dial kperera@domainA.com</a>

E.2 From the Command Line
You can start Bria from a DOS prompt. You may need to add Bria.exe to the PATH. Then type:

Bria30.exe

You can also run these action commands: 

Bria 3.0>Bria30.exe -action=<action>=<input>

where action and input are:

call?to         the remote URI

im?to         the remote URI

add?contact  the contact URI

quit
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F Glossary
AEC Acoustic echo cancellation. Processing of the audio or video signal to reduce the echo 

effect that can arise with a speakerphone or that can arise if the sound from the 
speakerphone or headphone leaks into the microphone. 

AGC Automatic gain control. Processing of the audio or video signal to adjust the 
microphone volume level so that the other party does not hear the distortion that 
might be caused by too high a microphone input or too low volume (due to too low 
input level).

AVI Audio Video Interleave. A multimedia container format. AVI files contain both audio 
and video data in a standard container that allows simultaneous playback.

Broadband Broad or wide bandwidth. In data transmission, the wider the band, the more data it is 
possible to transmit in a given time span. A cable, DSL and ADSL connection to the 
network provide broadband for data transmission. A dialup or ISDN connection 
typically provide a narrow bandwidth for data transmission.

Codec The format by which audio or video streams are compressed for transmission over 
networks.

Dial plan The rules that Bria follows in order to interpret the softphone address or phone 
number that the user has entered and to modify the number or address, as required, to 
ensure that the call will be placed successfully. 

DTMF Dual-tone multi frequency. DTMF is the system that is used in interactive voice-
response menu systems such as the menu system for accessing voicemail messages. 
The DTMF system allows the user to interact with the menu by pressing keys on a 
dialpad or keyboard.

HID Human interface device. In Bria, if the headset is HID-compliant, the user can 
configure the buttons on the device to invoke functions on Bria such as answering an 
incoming call.

IM Instant Messaging. A technology that lets users send text message and files for near 
instantaneous delivery and display on each others’ computers.

IP Internet Protocol. A data-oriented protocol used for communicating data across a 
network. IP is the most common protocol used on the internet.

IP address A unique number that devices use in order to identify and communicate with each 
other on a computer network using the IP standard. 

Media In a VoIP phone call, the audio and video portion of the information in a call. 
Compare to “Signaling”.

MWI Message Waiting Indicator. An indicator that there is a voicemail message for the 
owner of an account.

Narrowband In data transmission, the wider the band, the more data it is possible to transmit in a 
given time span. A cable, DSL and ADSL connection to the network provide 
broadband for data transmission. A dialup or ISDN connection typically provide a 
narrow bandwidth for data transmission.

Presence An instant messaging feature that allows users to share information about their online 
status.

Proxy See SIP account.
PSTN Public Switch Telephone Network. The traditional land-line phone network.
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RFC Request for Comment. A document that describes an aspect of an internet technology. 
An RFC may be a proposed, draft or full internet standard.

RTP Real-time Transport Protocol. A protocol for delivering the media portion of a data 
transmission over an IP network. SRTP is another media protocol.

Signaling In a VoIP phone call, the information in a call that deals with establishing and 
controlling the connection, and managing the network. The non-signaling portion of 
the call is the Media.

SIMPLE protocol Session Initiation Protocol for Instant Messaging and Presence Leveraging 
Extensions. The instant messaging (IM) protocol followed by Bria. It encapsulate the 
rules for exchanging instant messages.

SIP Session Initiation Protocol. The signaling protocol followed by Bria for handling 
phone calls. 

SIP account An account that provides the user the ability to make VoIP phone calls. The account 
encapsulates the rules and functions the user can access.

softphone address The address used to connect to a SIP endpoint. In other words, the “phone number” 
used in a VoIP phone call. For example, sip:joseph@domainA.com.

SRTP Secure Real-time Transport Protocol. A protocol for delivering the media portion of a 
data transmission over an IP network. SRTP is a secure protocol, which means that 
the media is encrypted. RTP is another media protocol.

TCP Transmission Control Protocol. A transport protocol for delivering data over an IP 
network. Other transport protocols are TLS and UDP.

TLS Transport Layer Security. A transport protocol for delivering data over an IP network. 
TLS is a secure transport protocol, which means that all the data being transmitted 
(signaling and media) is encrypted. Other transport protocols are TCP and UDP.

UDP User Datagram Protocol. A transport protocol for delivering data over an IP network. 
Other transport protocols are TCP and TLS.

URI Uniform Resource Identifier. A name or address that identifies a location on the world 
wide web. A softphone address is a type of URI.

URL Uniform Resource Locator. A URI that both identifies a name or address and indicates 
how to locate it. 

USB device Universal Serial Bus device. A device that follows a specific communications 
standard. A headset may be a “USB type” of headset. 

VAD Voice Activity Detection. A technology that detects if audio is a human voice or 
background noise. Bria includes a feature (Preserve bandwidth on the Network panel 
of the Preferences window) that controls whether audio is transmitted when VAD 
determines that no one is actually speaking.

vCard An electronic business card that is often attached to an e-mail. It often appears as a 
“signature” block that identifies the person, their title, and their business.

VoIP Voice over Internet Protocol. A variation of IP used for sending voice data over the 
internet, in other words, used for making phone calls over the internet.

VoIP service provider A business that provides a VoIP service, allowing a user to connect to the internet in 
order to make VoIP phone calls using Bria. The VoIP service provider sets up a SIP 
account for the user. 

WAV Or WAVE. A file format standard for storing audio on PCs.
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